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CHAPTER 1 DOCUMENT STANDARDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is important that companies have standards and guidelines in 
place for document preparation and production. Documentation 
standards ensure that quality documents are produced in the most 
efficient manner. 

 

In this session you will: 

 gain an overview of the different types of business 
documents 

 gain an understanding of the different types of software 
available for producing business documents 

 gain an overview of who prepares business documents 

 gain an overview of the various ways of speeding up 
document production 

 gain an understanding of aspects to consider when 
developing document standards 

 gain an understanding of good naming conventions for 
files and folders 

 gain an understanding of file formats and version 
compatibility. 
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TYPES OF BUSINESS DOCUMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A business must communicate with its 
customers, employees, suppliers, the 
government, and other businesses. This 
communication is mostly done through a variety 

of business documents. As a result there are a 
large number and variety of documents produced 
by businesses. 

A good way to understand the types of business documents produced in organisations is to examine 
the needs and requirements of the various parts of an organisation, and to group documents 
according to the functions performed. 

Management 

Management requires documents that help it make business decisions and help it keep the business 
running. These types of documents include: 

 Production reports 

 Sales reports 

 Meeting minutes 

Sales and Marketing 

Sales and Marketing require documents that help promote the business and its products to the 
customers. These types of documents include: 

 Price lists and order forms 

 Product brochures 

 Sales reports 

 Bulk mail-outs to customers 

Human Resources 

Human Resources deal with a variety of matters regarding employees. They require a very broad 
range of documents including: 

 Job descriptions 

 Employment forms 

 Training manuals and guides 

 Job procedures 

Manufacturing and Production 

Manufacturing and Production produce the goods and services sold by the business and require 
documents that help them produce these goods and services on time and in the most cost-effective 
manner. The types of documents they require include: 

 Production reports 

 Supplier price lists and forms 

 Product specifications and procedures 

Administration and Accounts 

Administration and Accounts are responsible for ensuring that the day-to-day operation of the 
business proceeds smoothly, that customers are invoiced, that bills are paid, that money is collected 
and banked, and the like. They require a variety of documents including: 

 Memos, faxes and letters 

 Sales reports 

 Accounting reports 
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CHOOSING APPROPRIATE SOFTWARE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The large number of documents required for 
businesses to operate can be produced by a 
variety of software packages and applications. In 
fact, many of the documents can be produced by 

more than one type of software application. It is 
useful to know about the role and function of the 
various software applications. 

Type of 
Document 

Typical Software 
Application(s) 

Level of 
Sophistication 

Comments 

Production reports  Spreadsheets 

 Database 

 Word processing 

 Specialised production software 

Low For internal communication 
only 

Sales reports  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Low For internal communication 
only 

Meeting minutes  Word processing Low For internal communication 
only 

Price lists  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

 Desktop publishing software 

Medium For internal use as well as 
external communication to 
customers 

Order forms  Word processing 
Desktop publishing software 

Low For customer use 

Product brochures  Word processing 

 Desktop publishing software 

High For customer use 

Merge letters  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Medium Used to communicate to 
customers 

Job descriptions  Word processing Medium For prospective job applicants  

Employment forms  Word processing 

 Desktop publishing software 

Low For internal use only 

Job procedures  Word processing Low For internal use only 

Supplier price lists  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Low For internal use only 

Product 
specifications 

 Database 

 Word processing 

 Accounting software 

Medium For customer use 

Memos, faxes, 
letters 

 Word processing Low For internal and external 
communication 

Accounting reports  Spreadsheets 

 Database 

 Word processing 

 Accounting software 

Low For internal use 
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WHO PREPARES BUSINESS DOCUMENTS? 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With such a diversity of business documents in 
use today, and with a variety of software 
applications available to create these documents, 
it is obviously not possible for one person or 

department to assume total responsibility for 
document preparation. So, who does prepare 
documents in a business? 

Standard Business Documents 

Standard business documents are relatively simple in layout, and are authored, printed and 
distributed by the same person within a company. These documents are usually memos, letters, 
faxes, minutes of meetings, and the like. The focus is more on the content and the subject matter 
than on the layout and overall appearance of the document. 

These would form the bulk of the documents produced within a company. 

These documents are usually produced on a personal computer or laptop and printed on the 
author‟s printer. Increasingly, these documents are circulated internally via email rather than 
through the mail system. 

Large companies often have directives that specify how these documents should be laid out. In 
small to medium companies, however, the look and layout of these documents is less formal and 
left to the discretion of the author. Many authors simply use the templates found in word 
processing applications to assist them in the layout of these types of documents. 

Specialised Business Documents 

Specialised business documents are by nature more complex and difficult to produce. These 
types of documents are usually colour brochures promoting the company and its products, 
annual reports for shareholders and investors, and the like. Often they incorporate pictures and 
artwork (graphics), and are produced as full-colour documents on high quality paper. 

These documents are usually produced by a team of people. Some of these people work within 
the company, while others are contracted by the company to perform a specific job. For example, 
the content is usually prepared by people within the company that are expert in the products and 
services of the company. However, these people do not usually have professional design and 
printing skills so these aspects of document production are outsourced to an external company 
that specialises in layout, design and printing. 

Generally, there are three steps to the production of these types of documents. 

1. The text (also referred to as the „copy‟) is prepared by the subject experts within the 
company. 

2. The text, relevant pictures and general information about the purpose of the document is 
handed over to a designer to lay out the design, choose the appropriate colours and 
fonts, and so on. 

3. The completed document is then provided in an electronic format to a printing company 
that prints the document in the quantities required by the company. 

Naturally, there should be someone within the company who manages and coordinates this 
process. If these documents are for sales and marketing purposes, it is usually someone from 
the marketing department who undertakes this role. 
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SPEEDING UP DOCUMENT PRODUCTION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Most software applications that are used to 
produce business documents contain a number 
of features that can speed up the production of 
documents. There are also things that can be 

done within a company to ensure efficient and fast 
document production. Some of the software 
features and company tasks are detailed below. 

Features Found In Software 

Macros 

Originally, macros were simply recorded keystrokes that could be stored and executed over and over 
again. These were used for the production of documents, or parts of documents, that remained the 
same from document to document. The keystrokes, such as a series of sequential steps to complete a 
specific task or perform an action, were recorded when the first document was created. They could 
then be replayed to create more of the same types of documents. Today, macros still perform the 
same role. However, they are now based on sophisticated programming commands and languages 
and, while still relatively easy to use, offer much more power than earlier keystroke macros. 

Themes 

Themes let you create professional-looking documents with a co-ordinated set of colours, fonts and 
backgrounds in a flash. By applying one of the 40 built-in themes you can change the overall look of 
your document immediately. To make the best use of themes, however, you will need to apply styles 
(via the Home tab) to the various elements in the document. 

Templates 

One of the most tedious tasks in document production is designing the layout and overall presentation 
of a document. A template allows you to create a document based on an existing design and can save 
much production time. Templates can also be created from an existing document. The existing 
document is converted into a template and the design of that document can then be used to produce 
future documents. 

Styles 

Longer documents require consistency in the look of their headings, text, tables, and the like. Styles in 
word processing applications allow you to store a set of formatting attributes and then apply that 
formatting to different parts of the document. For example, you can create a style for main headings 
that consists of a range of formatting attributes, such as a specific font style, font size, adjusted 
paragraph spacing, etc. You can then apply that style to any text that you want to use as a main 
heading. If you later want to change the way those headings look, you only need to change the style 
and all of the headings will automatically update. Styles can save a considerable amount of time in 
document production. 

Building Blocks 

You can recycle content that you use constantly in your business, such as contracts, agreements, 
procedures and the like, by creating and using building blocks. For example, you might save your 
company‟s contact information as a building block in the Quick Parts gallery, and whenever you 
require that information, you can simply open the Quick Parts gallery and select the desired building 
block. 

Speeding Up Document Production 

Guidelines and standards 

One of the most time-consuming aspects of document production is deciding how you want it to look – 
what fonts to use, colours, margin settings, headers, footers, and so on. It is extremely beneficial for 
any company to have a set of procedures and guidelines that define these aspects of document 
production for authors. Every company, even the smallest, will decrease production time by having a 
set of standards in place. In addition these should be incorporated into a standard set of company 
templates (see above) which can be easily accessed by authors. 
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ESTABLISHING DOCUMENT STANDARDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is important for all companies, both small and 
large, to have a set of guidelines and standards 
in place for document production and handling. 
These guidelines ensure a consistent look and 

feel amongst the documents, allow new employees 
to become quickly acquainted with document 
production, and convey a professional image of the 
company to its customers and clients. 

Things To Consider When Developing Document Standards 

Storage 

It is important that company documents can be located and accessed by relevant people. 
Documents can be stored on a personal computer or on a network server. If company documents 
are stored on a personal computer, and if those documents are to be made available to other users, 
then the documents should be stored in shared folders that are accessible to other users on the 
network. Generally, it is advisable for public documents to be placed on a network server if one 
exists. Some liaison with the network administrator may be necessary to ensure that document 
authors have appropriate access rights to the network. 

Folder and file naming 

It is important that the company implements a standard for file and folder naming. Using proper 
guidelines ensures that important documents can be found easily in the future. A handy technique 
used in document production is to include the file name and folder path somewhere in the 
document. This can be in the header, the footer, on the front or last page, or even in the document 
properties. The desired method should be clearly detailed in the company guidelines. 

Templates 

Detailed information should be placed in the guidelines with regard to what templates are available 
for document production. There should also be instructions explaining how the templates are to be 
used, where they can be accessed, and appropriate information detailing what can and what can‟t 
be altered in the templates. 

Company logos, colours and general branding 

Most companies have an established logo, colour scheme and other form of branding. The 
guidelines should clearly indicate what these are, what the minimum and maximum sizing for logos 
is, the placement of logos, the colour of the text, and other branding issues. 

Styles 

The document guidelines should contain information about the size of font, line and paragraph 
spacing, and indents that are to be used for the body text (the general text), headings, table text, 
figure text, captions, and other text in the document. 

Output 

The document guidelines should include detailed information about how the document should be 
produced. For example, many computer printers will print in draft mode and quality mode. The 
guidelines should indicate when it is appropriate to print the document in quality mode (which is 
more expensive and sometimes slower). Also, it is increasingly popular to transmit documents 
electronically via email. The guidelines should indicate when documents are to be printed on paper 
and when they are to be transmitted electronically. 

Review of standards 

It is not possible to lock in standards forever – needs and technology are changing too fast to make 
this possible. Consideration should be given, therefore, as to how frequently the standards will be 
reviewed and how the amendments will be provided to the user. 
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UNDERSTANDING NAMING CONVENTIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

These days, the storage devices on your 
computer are typically huge in capacity – they 
allow you to store an almost unlimited number of 
document files. So, unless you have an efficient 

system for naming your files and folders, you are 
going to have one heck of a time finding a 
document that you created last week, or last 
month, or last year. 

Technical Considerations 

When you save the work that you are doing on the computer, it is placed into an electronic file. In 
order to retrieve the file for later use the computer needs to be able to identify the file using three 
components: the file path, the file name, and the file extension. 

A computer file is normally stored in a folder on a storage device accessible to the computer. Folders 
can have sub-folders, which in turn can also have sub-folders. So a file path (i.e. its location) is 
identified by specifying the device letter followed by a colon, and then the folder hierarchy in which it 
can be found. Each element in the path is separated by a backslash (\). For example, when you use 
the default My Documents location to save a letter, its actual file path will be something like: 

C:\Users\Fred\My Documents 

The file name is something that you create and can be up to 255 characters in length. It can include 
spaces but there are special punctuation characters that have other meanings to the computer that 
cannot be used. These include the question mark (?), quotation mark (“), slash (/) and backslash (\), 
greater than (>) and less than (<), asterisk (*), pipe (|), and colon (:). 

The file extension is usually 3 or 4 characters in length and is automatically provided by the 
computer. It is separated from the file name using the full stop character. 

Your Responsibility 

It is your choice both where you choose to save a file and what it should be called. You can save a file 
in the default location (My Documents) or create your own hierarchy of folders and sub-folders for 
your files. If you create your own folders they too will need to be named and the same technical 
considerations above apply to folder names as for file names. 

Before You Save A File… 

Many companies, universities, schools, and other organisations already have policies and standards 
in place associated with electronic files. For example, if you are creating files at work, there is a good 
chance that they will need to be saved on a network and there may even be specific instructions for 
naming those files. Even at home some people have initiated procedures for storing homework files 
(oh, and probably also music and video files!) on an external drive. 

So, before you save a file, check to see whether there are any guidelines, policies or procedures in 
place where you are. 

Some General Guidelines 

If you can‟t locate any specific procedures for naming files where you are then here are some general 
guidelines you should follow (you‟ll find many more by Google searching file naming conventions: 

 Even though you have 255 characters at your disposal for a file name, keep your names short 
and meaningful (long names take ages to type and are difficult to fully display). 

 Choose whether you want to separate words in the file name with spaces, dashes, or 
underscores, then stringently adhere to whatever you decide and remain consistent. 

 If you are using a date in the file name always state the date back-to-front using four digits for 
the year and two each for the month and day (e.g. YYYYMMDD). The computer files things 
alpha-numerically and this is the best way to ensure files are displayed in the correct order. 

 If you are using a personal name in a file name start with the family name first and then the 
initials. 

 Use an underscore at the start of a file name if you want that file to “float” to the top of the 
alpha-numeric listing – this is handy for temporary or draft files still subject to review and final 
editing. 

 Avoid cryptic anagrams and letters. 
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UNDERSTANDING VERSION COMPATIBILITY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Word 2010 saves documents in a format 
compatible with both Word 2010 and Word 
2007. Word also allows you to save your 
document in other file formats such as a web 

page or as a PDF document. You can also save 
documents with backward compatibility, enabling 
the document to be opened and read by those 
using a version of Word earlier than Word 2007. 

File Compatibility 

Word 2007 underwent a major change in the way that it internally saved documents. Basically, 
document files saved in versions of Word prior to Word 2007 were saved as binary files – binary 
files are a closed file format that cannot be readily opened or modified without the same software 
used to create them. 

Since Word 2007, document files are saved as XML (eXtensible Markup Language) files. Without 
going into too much detail, XML was originally developed as a more flexible and open file format 
which theoretically allows a lot more sharing and manipulation of content and data. 

Documents prior to Word 2007 are identified with a .doc file extension, while XML files saved in 
Word 2007 and Word 2010 can be identified with a .docx file extension. 

Any of the Word file types you save in Word 2010 will be based on an XML structure. 

Other File Formats 

Word enables you to save your documents in a range of other file formats. This ensures that anyone 
can view your document even if they don‟t have Word installed on their computer. In Word 2010, you 
can save your documents in the following file formats. 

 Word 2010 documents and templates. By default, Word 2010 documents are saved with 
the file extension .docx, and templates are saved with the file extension .dotx. The x 
indicates that the file is based on XML. 

 Macro-enabled documents and templates. Documents and templates that contain macros 
must be saved as a macro-enabled document (.docm) or macro-enabled template 
(.dotx). 

 Word 97-2003 documents and templates. To enable others using Word 2003 and earlier 
to view your documents and templates, save your document as a Word 97-2003 Document 
(.doc) and save your templates as a Word 97-2003 Template (.dot). 

 PDF and XPS documents. To ensure that anyone can view your document, even if they 
don‟t have Word installed, and to preserve the layout and formatting of your document, you 
can save the documents as a portable document format (.pdf) or XML paper 
specification (.xps) document. Anyone with a PDF viewer can read these document types. 
It is common to save a document as a PDF, for example, when making documents available 
for others to download from the internet. 

 Web-based file formats. Where you want to make the document or its content available on 
the internet, such as for creating a website, or for editing in a HTML editor, you can save the 
document in a range of web-based file formats, including HTML and MHTML. 

 Rich text format. To ensure that a document and its formatting can be viewed in a program 
specific to a particular platform (such as Mac) or operating system (such as Unix), you can 
save the file as a rich text format (.rtf). The file can then be edited in the destination 
program, and the program will interpret and apply the formatting accordingly. 

 Open Document format. Saving a document in this format will ensure that those who use 
open source (free) software can view and edit the document. Most software produced as 
open source will support this format. Note that you may lose some formatting when saving in 
this format. 
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DOCUMENT STANDARDS 

Practice Exercise 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the 
topics in the chapter Document Standards… 

 


Open the document called PE_Document Standards.docx (it can be 
found in the same folder as the student files) 

 


Answer the questions which are included in the document 

A sample of the questions is shown on the next page... 

 


Use Save As to save the document as PE_Document Standards 
(Completed).docx 

 

 

Files required for 
exercise: 

PE_Document Standards.docx 

Files/work created by 
student: 

PE_Document Standards (Completed).docx 

Exercise Completed:  
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DOCUMENT STANDARDS 

Practice Exercise 
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CHAPTER 2 MULTIPLE DOCUMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A distinct advantage of working with a word processing application 
is the ability to work with multiple documents simultaneously. For 
instance, having multiple documents open at the same time can be 
useful if you are creating a summary report, drawing information 
from a number of different source documents. 

To assist you in working with multiple documents, you are able to 
easily switch between them or display multiple windows on the 
screen side-by-side or tiled underneath each other. 

In this session you will: 

 learn how to open multiple documents simultaneously 

 learn how to switch between multiple open documents 

 learn how to arrange all open documents 

 learn how to view two documents side by side 

 learn how to use synchronous scrolling 

 learn how to reset the window position when using side 
by side view 

 learn how to save a document for an earlier version of 
Word 

 learn how to save a document in PDF format 

 learn how to save a document as plain text 

 learn how to save a document with thumbnail preview 

 learn how to add properties to a document. 

INFOCUS 
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OPENING MULTIPLE DOCUMENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 F
il

e
 

Before starting this exercise 
you should close all Word files 
that are currently open... 


Click on the File tab and click 
on Open to display the Open 
dialog box 


Navigate to and double-click 
on Course Files for Word 
2010 in the Folders list 

This will display the files 
available in this folder... 


Locate and click on W817 
Multiple Documents_1.docx 
to select it, then click on 
[Open] 

The one document will now be 
open. More documents can be 
opened at any time, either 
individually or several at the 
same time... 


Repeat step 1 to display the 
Open dialog box 


Click on W817 Multiple 
Documents_2.docx 


Hold down  and click on 

W817 Multiple 
Documents_3.docx 

The two documents will now 
be selected... 


Click on [Open] to open both 
documents simultaneously 

 

For Your Reference… 

To open multiple documents simultaneously: 

1. Click on the File tab and click on Open 

2. Hold down  and click on the documents 

to open 

3. Click on [Open] 

Handy to Know… 

 To select a range of contiguous files in the 
Open dialog box, click on the first file then 
hold down  and click on the last file in 

the range – all files in between will be 
selected. 

 You can display the Open dialog box by 
pressing the keyboard shortcut  + . 

2 

6 

Opening multiple documents in Word enables 
you to work with them at the one time; very 
convenient if you want to locate information from 
a document created previously and insert it into 

another document. There are several ways to open 
a document in Word – you are probably already 
familiar with opening one document at a time – now 
let’s see how to open multiple documents. 
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